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Section A. PROJECT MANAGEMENT ELEMENTS 
This section describes the design and implementation of the project. Implementation of these 
elements will ensure that appropriate methods for sampling, measurement and analysis, data 
collection or generation, data handling, and QC activities are employed and are properly 
documented. 
 
A3. Distribution list 
EPA: 
Steve DiMattei, Quality Assurance Officer, U.S. EPA Region 1 - New England Regional Laboratory, 
11 Technology Drive, North Chelmsford, MA 01863-2431, dimattei.steve@epa.gov 
 
Ann Rodney, U.S. EPA, 5 Post Office Square - Suite 100, Mail Code - OEP-06-1, Boston, MA 
02109-3912, (617) 918-1538, rodney.ann@epa.gov 
 
Additionally, copies will be on file with the Massachusetts Office of Coastal Zone Management, 251 
Causeway St., 8th Floor, Boston, MA 02114 
 
A4. Project and task organization 
Activities for this project will involve principally an analysis of GIS datasets. The three project leads 
will develop the necessary GIS coverages and will prepare the final project report and maps for each 
municipality. 
 
Some fieldwork will be undertaken by the BBNEP wetland specialist to confirm plant species that 
coincide with features evident on aerial photographs. In these cases, the wetland specialist will use a 
Trimble GeoXT unit that has a nominal 0.5-meter horizontal accuracy. This fieldwork will not be 
used to define marsh boundaries for the purposes of the study, but to show sample vegetation types 
at the calculated high tide line, and for case studies on the application of the maps generated by this 
study. 
 
Project Manager: Joseph Costa, Buzzards Bay National Estuary Program (NEP) Executive 
Director, is the overall project manager, lead principal investigator for the project, and is responsible 
for analysis and integration of datasets, communication, project management, maintaining and 
distributing the QAPP, and project reporting. He will develop GIS spatial coverages representing 
changes in the flood zone. 
 
GIS Analyst: John Rockwell, Buzzards Bay NEP Wetland Specialist, will develop GIS spatial 
coverages representing physical boundaries of salt marsh units, which will be used as boundaries in 
the calculation of areas defining their potential expansion inland because of sea level rise. He will 
also conduct GPS field verification to document vegetation types at selected sites at the high tide 
elevation, and to document or evaluate the location of transition zones between salt and freshwater 
systems. This information will be used to evaluate the general reliability of calculating salt marsh 
boundaries based on high tide line elevations calculated using the VDatum tidal elevation model 
(version 3.2, March 2013) and the methods described here. 
 
Quality Control Officer: David Janik, Massachusetts Coastal Zone Management, South Coastal 
Regional Coordinator, is the quality control officer for this project, and will ensure that the 
protocols described here are adopted. 
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A5. Problem definition and background 
Coastal salt marshes are an important habitat and nursery for many coastal marine species of plants, 
aquatic and terrestrial vertebrates, and invertebrates. Other functions provided by salt marsh 
ecosystems include storm damage prevention, prevention of pollution, protection of marine fisheries 
and wildlife habitat, and a source of primary production carbon that is the basis of coastal food 
webs. Salt marshes also contribute to aesthetic values of the coast. Historically, many salt marsh 
areas in Buzzards Bay have been filled or otherwise adversely affected by human activities.  
 
Since the end of the last ice age, sea levels have risen hundreds of feet, and salt marshes have 
migrated inland in concert with the coastline. In recent centuries, it is believed that most salt 
marshes in protected areas have been able to accrete vertically to keep pace with rising sea level that 
stands at roughly 10 inches per century relative to the local rate. With global warming, the rate of sea 
level rise may increase. If vertical accretion within salt marshes cannot keep pace with rising sea 
levels, and if they cannot migrate inland, they will be lost. 
 
Besides the potential threat of increased rates of sea level rise and their ability to accrete sediments 
to keep pace, two impairments are common in surviving salt marshes. First, many salt marshes have 
had tidal exchange with the ocean restricted by road construction and undersized culverts. Second, 
road construction, raised fill areas with steep grades, bulkheads, and similar features have raised 
adjoining land elevations to such an extent that a boundary is created that prevents further inland 
migration of salt marshes under the sea level rise scenarios. 
 
For this study, we will estimate the predicted landward expansion of the high marsh boundary with 
sea level rise based on a simple "bath tub" model approach using a methodology recommended by 
NOAA, with some modification1. This approach is based on modeled tidal datum elevations in 
NOAA's VDatum model to estimate local tidal datum elevations that approximate the existing high 
marsh boundaries around Buzzards Bay2. The mapping process used is also similar to the approach 
used by the NOAA Coastal Services Center to map sea level rise inundation for their Sea Level Rise 
Viewer3. The expansion of the boundaries of the marsh with sea level rise will be based on a bathtub 
model approach using the calculated high tide line elevation, applied to LiDAR4 digital elevation 
model data. 
 
A5.1. Definition of high marsh boundary 
New England salt marshes are typically classified into three intertidal zones: low, middle, and high 
marsh based on the assemblage of plant species found in each (e.g., Redfield 1972; Nixon 1982; 
Bertness, 1992; Donnelly and Bertness 2001). The plant species assemblage in each of these zones is 
defined by the frequency of tidal flooding and the average inundation time. In Buzzards Bay, the low 
marsh is dominated by cord grass, Spartina alterniflora, and begins roughly at mean sea level (MSL). 
                                                 
1 NOAA (undated). "Detailed methodology for mapping sea level rise marsh migration:" available at 
www.csc.noaa.gov/slr/viewer/assets/pdfs/Marsh_Migration_Methods.pdf. Last accessed 29 May 2013. See also 
Myers (2005). 
2 VDatum 3.2 (2013) uses GEOID12a, whereas the FEMA 2006 LiDAR uses GEOID3 and the 2010 Northeast 
LiDAR data GEOID09. Because the upper portions of Buzzards Bay are higher by 3.5 cm in GEOID12a, grading to 
less than 1 cm in lower Buzzards Bay, these differences in the NAVD88 elevations will need to be accounted for. 
3 See NOAA CSC 2011. 
4 Light detection and ranging (also abbreviated LiDAR and LADAR) is an optical remote sensing technology that 
can measure the distance to a target by illuminating it with pulse of light from a laser. 
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The middle marsh area, occurring roughly between mean high water (MHW) and mean high higher 
high water (MHHW) is dominated by Spartina patens, Salicornia spp., Distichlis spicata, and Juncus 
gerardii. The high marsh environment occurs above MHHW, and vegetation includes mid-marsh 
species as well as the invasive Phragmites australis. The transition between the high salt marsh and 
upland areas include certain characteristic species such as the high tide bush Iva frutescens, and switch 
grass, Panicum virgatum. Salt marshes may also grade into freshwater wetlands. The actual real world 
elevation of all these boundaries with respect to local tidal datums depends on numerous factors 
ranging from fresh water inputs to levels of eutrophication (Bertness et al. 2002, 2009; Silliman and 
Bertness, 2004). 
 
Under the Massachusetts Protection Act regulations (310 CMR 10.0), a salt marsh is defined as "a 
coastal wetland that extends landward up to the highest high tide line, that is, the highest spring tide 
of the year, and is characterized by plants that are well adapted to or prefer living in, saline soils. 
Dominant plants within salt marshes are salt meadow cord grass (Spartina patens) and/or salt marsh 
cord grass (Spartina alterniflora)."  
 
In federal regulations (33 U.S.C. 1344, Regulatory Program of the US Army Corps of Engineers, 
Part 328.3), the "high tide line"(sometimes called the annual high tide) is defined as "the line of 
intersection of the land with the water's surface at the maximum height reached by a rising tide. The 
high tide line may be determined, in the absence of actual data, by a line of oil or scum along shore 
objects, a more or less continuous deposit of fine shell or debris on the foreshore or berm, other 
physical markings or characteristics, vegetation lines, tidal gages, or other suitable means that 
delineate the general height reached by a rising tide. The line encompasses spring high tides and 
other high tides that occur with periodic frequency but does not include storm surges in which there 
is a departure from the normal or predicted reach of the tide due to the piling up of water against a 
coast by strong winds such as those accompanying a hurricane or other intense storm." 
 
Not explicit in the state and federal regulations is the fact that the high tide line refers to the current 
high tide line during the recent year, and not an average for the current tidal epoch. The tidal 
definitions used in this tidal studies and various regulations are summarized in Table 2, which also 
shows Newport tidal datum elevations. Most of Buzzards Bay has tidal characteristics similar to that 
of the Newport Tidal station.  
 
Table 2. Elevations of Newport Tidal Datums (1) converted to NAVD88 GEOID 12a 

Datum Abbreviation 
Range 

Ft
Elev. Ft 

NAVD88 Description 
HTL for 2013 (salt marsh reg. boundary) 3.06 high tide line (aka annual high tide) 
MHHW (typ. S. patens monoculture) 1.81 mean higher high water 
MHW  1.57 Mean High Water 
DTL  -0.11 Mean Diurnal Tide Level 
MTL -0.16 Mean Tide Level 
LMSL (typ. S. alterniflora edge) -0.30 Local Mean Sea Level 
MLW  -1.90 Mean Low Water 
MLLW -2.04 Mean Lower Low Water 
GT  3.85 Great Diurnal Range(MHHW-MLLW) 
MN  3.47 Mean Range of Tide (MHW-MLW) 
As reported at: http://tidesandcurrents.noaa.gov/data_menu.shtml?stn=8452660 Newport, RI&type=Datums, 
Accessed 24 May 2013. 
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For this study, a practical definition of the upper salt marsh boundary is needed. Based on field 
observations matched to LiDAR data around Buzzards Bay, the Buzzards Bay NEP has determined 
that the annual high tide or high tide line (HTL) of larger non-tidally restricted salt marshes tends to 
coincide with a transitional vegetation zone between marsh species and upland species (e.g. Iva 
fructens grading to cedar uplands as evident in aerial photographs). Areas dominated by Spartina patens 
(i.e. the high marsh) tend to occur somewhere between the MHHW elevation and the HTL 
elevation. Areas above the HTL are generally easy to distinguish on aerial photographs due to the 
presence of cedar trees and other shrub and tree vegetation types. 
 
Rather than attempt to make an ecological determination of the boundary of areas dominated by 
Spartina species, which tend to occur somewhere between the MHHW and HTL and would require 
extensive fieldwork, for this study we settled upon a calculated HTL elevation (using VDatum and 
local NOAA Tidal station records). The selection of the HTL elevation as the definitive salt marsh 
boundary ensures consistency with the definition of the salt marsh boundary under state regulations, 
and matched the federal definition of the boundary of tidelands.  
 
However, we have also determined that the predicted HTL using the methods described here is not 
a good predictor for defining marsh boundary in the upper portions of large estuaries. This may be 
because VDatum does not model well these upper estuary areas.  In these instances it would be 
incorrect to assume that the VDatum derived HTL elevation at the mouth of these estuaries 
matches the HTL elevation in the upper estuary. For example, in the uppermost portions of the 
Acushnet River and East Branch of the Westport River, the apparent marsh boundary elevation is 
0.5 to 0.7 feet lower than the HTL elevation at the mouths of the respective estuaries. In these 
environments, if the HTL elevation near the mouth of the bay does not coincide with marsh 
boundaries in the upper estuary, we will instead use a LiDAR elevation that best coincides with salt 
marsh boundaries evident on aerial photographs. These elevations will be used as a starting point, 
and 1- 2- and 4 feet will be added to those revised elevations for the sea level rise scenarios. 
 
Some fieldwork will also be conducted for this analysis. However, this fieldwork will not be used so 
much to set marsh boundary, but rather to document vegetation types (through photography) near 
the HTL elevation at selected sites to evaluate the overall reliability of the approach. This fieldwork 
will also be used to document fresh and brackish wetland species at selected tidally restricted 
marshes to illustrate how the GIS data generated by this study can be used. In a few estuaries where 
there are apparent discrepancies between VDatum and salt marsh vegetation in unrestricted areas, a 
new VDatum elevation will be selected based on best professional judgment using aerial 
photographs and LiDAR data. 
 
A6.1. Task Description Overview  
This geospatial project will use existing data from a source external to the Buzzards Bay National 
Estuary Program5. These datasets will be manipulated to create new maps to be used for planning 
purposes. The overall strategy for this effort is to demarcate the high tide line (HTL) elevation (also 
                                                 
5 The 2006 LiDAR coverage was obtained from FEMA and was used in part to prepare the updated Bristol and 
Plymouth County FIRMs (CDM Smith, 2008). The 2010 LiDAR coverage was collected through the Northeast 
LiDAR Project and covers Barnstable County. These LiDAR data exist as bare-earth digital elevation models 
(DEMs) in the form of triangular irregular network (TIN) or Imagine raster files. In general, the elevation precision 
of the LiDAR data is 1 cm, but the accuracy is generally approximately 6 inches over the entire southeast study area. 
The relative accuracy over a small geographic area along the same flight path is considerably better (USGS, 2004). 
The two data sets are sufficiently consistent for the purposes of this study. 
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known as the annual high tide or AHT) in each available LiDAR dataset. This calculated elevation 
will be used to define the salt marsh boundary in the LiDAR data sets. We will extrapolate the 
expansion of this boundary under the various sea level rise scenarios. 
 
The high tide line will be calculated based on the VDatum model6 and supplemented by NOAA 
tidal predictions for the 2013 annual high tide7. The VDatum tidal model dataset used in this study is 
the definitive tidal model used by NOAA for general sea level rise studies. VDatum predicts mean 
higher high water (MHHW) elevations, but does not predict the somewhat higher high tide line 
elevation. The difference between these two elevations has been modeled by the Buzzards Bay NEP 
as described in the sections below. The Buzzards Bay NEP has already modeled the high tide line 
elevation for all of Buzzards Bay. This high tide line will be applied to the LiDAR data sets to create 
polygon boundaries for existing marshes. This work will take two months and will be completed in 
the fall of 2013. 
 
The methods adopted here are similar to the aforementioned NOAA model8 with one important 
exception. We will only map the inland migration of upper marsh boundary; we make no estimates 
about the ability of marshes to be able to accrete with different rates of sea level rise.  
 
It is worth stressing that no field data is needed to define marsh boundary under this approach. We 
will, however, conduct field visits during the fall of 2013 with cameras and GPS units, in different 
parts of Buzzards Bay. These field visits will be used to document vegetation types at the high tide 
line elevation at selected locations in different parts of Buzzards Bay. This information will not be 
used to define the high tide line boundary, as that elevation is based strictly on applying the 
calculated high tide line elevation to the LiDAR data set. Rather, these field visits and photographs 
will be used for general informational purposes, and to identify areas where fresh or brackish 
wetland species exist within the expected salt marsh boundary. These field investigations are not 
meant to be comprehensive. Rather, they will be used to provide examples of how the results of this 
study can be applied to investigations of tidally restricted salt marshes and salt marsh expansion. 
 
A6.1.1. Defining marsh boundaries in the context of LiDAR datasets 
The analysis will be undertaken using ArcGIS® software by Esri9. As noted above, the Buzzards Bay 
NEP has already calculated the high tide line (HTL) elevation for the coastline of Buzzards Bay, and 
this elevation will be used to define the boundary of salt marshes. Although the calculation of the 
elevation of the HTL around Buzzards Bay is complete, we provide below a detailed explanation of 
the methods used to define the HTL so that underlying modeling assumptions are understood and 
can be transferred to other studies. Applying this elevation to the LiDAR digital elevation model 
datasets will take 2 months and will be complete by November 2013.  
  

                                                 
6 VDatum uses model grid files for each tidal datum in Table 2 (excluding annual high tide) for the Massachusetts to 
Maine Region based on NOAA CO-OPS tidal station data, adjusted to the current epoch. VDatum interpolates these 
values and accounts for GEOID and datum conversion to enable conversion of all key local tidal datums to 
NAVD88 GEOID12a. 
7 Available at http://tidesandcurrents.noaa.gov/tide_predictions.shtml?gid=37 
8 "Detailed methodology for mapping sea level rise marsh migration" see footnote 1. 
9 ArcGIS® software by Esri (ArcMap desktop versions 9.3 and 10.1) will be used to define salt marsh boundaries to 
meet the High Tide Line elevation, and through expansion of these boundaries based on a bathtub approach. 
Additional analysis will be completed in spreadsheets using pivot table functions.  
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Real world tidal elevations and tidal ranges vary around Buzzards Bay. Based on a review of LiDAR 
data and field observations in 2013 (including observations of king tides in June), the Buzzards Bay 
NEP determined that annual high tide elevation is a reasonable approximation of the high marsh 
transitional zone to upland species in non-tidally restricted areas. However, the high tide line 
(=annual high tide) is not an output function in the NOAA VDatum model, so the elevation must 
be approximated. 
 
Data for the HTL is available for 20 tidal stations in and around Buzzards Bay. For these elevations, 
we used the specific predicted annual high tide elevations above the local tidal datum as reported by 
NOAA for June 23, 201310. Based on Guidance from NOAA, we omitted two anomalous station 
outlier values11. We used as a starting point the real world elevations of the mean higher high water 
elevation as calculated by the VDatum model (Fig. 1). Using the HTL elevations above MHHW for 
the 18 tidal stations in and around Buzzards Bay, we interpolated these values using Spatial Analyst12 
to generate a model of the HTL elevation above MHHW for Buzzards Bay (Fig.2). These elevations 
were added to the elevations of MHHW in Fig. 1 to calculate the real world elevation of the annual 
high tide. It is worth noting that precision of the HTL adjustment exceeds the precision of 
individual tidal stations (harmonic stations have an assumed accuracy of 0.1 foot, subordinate 
stations have an assumed accuracy of 0.25 foot), but collectively these station values provide the 
basis for establishing the elevation of the HTL above MHHW across Buzzards Bay. These 
limitations will be discussed in the final report. 
 
While the LiDAR datasets and VDatum all use the same datum (NAVD88), each uses a different 
GEOID model. We used for this study, the most recent version of VDatum (version 3.2, March 
2013), which employs GEOID12a, whereas the 2006 FEMA LiDAR dataset (the western shore of 
Buzzards Bay) uses GEOID3, and the 2010 Northeast LiDAR dataset (eastern shore of Buzzards 
Bay through Butler Cove, just south of Buttermilk Bay) used GEOID9. These GEOID differences 
must be accounted for. More specifically, to select the correct LiDAR elevation corresponding to a 
specific VDatum elevation, the elevations shown in Figs. 3 and 4 must be subtracted. As shown, the 
GEOID12a to GEOID9 adjustment is trivial, but the GEOID12a to GEOD3 is more significant, 
especially in the southern areas of Buzzards Bay. 
 
One additional adjustment must be made to account for the fact the VDatum and NOAA predicted 
tides are based on data from the last 19-year tidal epoch (1983-2001), and thus represent the mid-
point (1992-1993) average conditions. Because there have been 20 years of sea level rise since 1993, 
we added 0.17 feet (the estimated sea level rise for our area based on Newport and Woods Hole 
average SLR rates) to the HTL calculation to estimate the real world elevation of the HTL in 2013. 
 

                                                 
10 Available at http://tidesandcurrents.noaa.gov/tide_predictions.shtml?gid=37. Last accessed 24 June 2013. 
11 Todd Ehret (NOAA Center for Operational Oceanographic Products and Services), pers. comm. The Clarks Point 
station was omitted because it was had an anomalously low HTL above MHHW compared to surrounding stations. 
This anomalous value may be related to the fact that it was based on an older short term data set (only five months 
of tidal records in 1976). The Quicks Hole station data had an anomalously high HTL elevation above MHHW, and 
was omitted for several reasons. This station is on the south side of a peninsula at the boundary of Buzzards Bay and 
at the nexus of two tidal regimes. The tidal transition zone in these areas is quite narrow, however, the GIS point 
interpolation tool used to create the HTL elevations in this study gives this single point too much weight across 
central Buzzards Bay. To avoid the bias generated by this outlier, it was omitted. 
12 ArcGIS 10.1 tool called "interpolation spline with boundary." 
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Finally, we note that both LiDAR datasets are expressed as bare earth digital elevation models. 
Various LiDAR studies of salt marshes have found that reported bare earth LiDAR elevations must 
be adjusted for grass canopy. This is because, even during winter time when LiDAR data is collected 
typically, dead Spartina spp. blades form a matted dead might still be 3-25 cm thick (e.g. Schmid et 
al., 2011; Hladik and Alber, 2012). However, because the HTL boundary is typically well above the 
Spartina monoculture, and these transitional areas (often at the edge of small coastal banks) typically 
have species where bare earth is evident at the time of LiDAR surveys, we made no adjustment for 
Spartina canopy in this study. 
 
Based on the methods and studies summarized above, the calculated annual high tide elevation in 
the two respective LiDAR datasets are shown in Fig. 5 (=Fig. 1 values + Fig. 2 - [Fig. 3. or Fig. 4] + 
SLR increase since 1993).  
 
 
A6.1.2. Creation of salt marsh expansion zones with sea level rise scenarios 
We assumed that the boundary of salt marsh systems in non-tidally restricted areas to be equal to the 
estimated annual high tide elevations shown in Fig. 5. For each salt marsh system around Buzzards 
Bay we applied the elevation shown in Fig. 5, and to that elevation we added 1-, 2-, and 4- ft to 
project the corresponding sea level rises. For example, in West Falmouth, a marsh boundary 
elevation of 3.2 feet (LiDAR elevation based on HTL elevation and aforementioned adjustments) 
was selected, and land areas bounded 4.2, 5.2, and 7.2 feet in the LiDAR bare earth DEMs was 
calculated. 
 
The selected 1-, 2-, and 4-ft elevation increases in this study were chosen as convenient management 
elevation markers for local municipal planners and resource managers. The relative sea level rise rate 
documented for Woods Hole, MA has been 10.3 inches per century since 193013. The IPCC (2007) 
consensus range for sea level rise, applied to this region, is 1 to 4.5 feet by year 2100. However, 
some other studies with alternative scenarios with more expanded Greenland and Antarctic glacier 
melting, or changes in the North Atlantic gyre may result in higher local sea level rise rates. We thus 
leave open ended how quickly the 1, 2, and 4-ft elevation increases may occur. 
 
The HTL elevation is a regulatory boundary, and represents the assumed approximate ecological 
boundary of salt marsh species. However, in tidally restricted areas, vegetation at the HTL elevation 
may in fact be composed of brackish or freshwater wetland species. In this study, we will demarcate 
these non-salt marsh vegetation areas to identify sites that may benefit from the removal of tidal 
restrictions. This information will represent an improvement over the analysis contain in the 2002 
Atlas of Tidally Restricted Salt Marshes in the Buzzards Bay Watershed Massachusetts. This information 
(maps of non-marsh vegetation below the HTL elevation) can be used to prioritize tidally restricted 
sites for restoration. 
 
The findings of this study will be summarized in a report and maps for each studied site, the entire 
bay, and for evaluated marshes in each municipality. These documents are expected to be used by 
both the state and municipalities for general planning purposes related to climate adaptation and to 
help prioritize salt marsh protection, restoration, and land protection efforts for each community. 
  
                                                 
13 Data available at http://tidesandcurrents.noaa.gov/sltrends/sltrends_station.shtml?stnid=8447930. This is the 
average rate for the period 1932 to 2006.  
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Fig. 1. Estimated MHHW elevations in Buzzards Bay as NADD88 ft (GEOID12a, VDatum 3.2, March 
2013). Embayments shaded black have no prediction in VDatum. 
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Fig. 2. Estimated annual high tide elevation above MHHW. The bay and embayments are shaded to show the 
modeled elevation of the high tide line above MHHW according to the key on the right (elevations in feet). 
This model surface was calculated using the 18 data points shown, which represent the actual NOAA tidal 
datum station locations, and the actual elevation of the high tide line above MHHW at those stations. All tidal 
elevations were converted to NAVD88 ft GEOID12a using VDatum 3.2 (March 2013). The modeled base 
map raster was generated using these data points with a Spline interpolation using the coast as a boundary 
using Spatial Analyst. One point on the Rhode Island coast was used but is not shown on the map. See text 
for additional explanation on omitted values. 
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Fig. 3. Adjustment in converting NAVD88 GEOID3 elevations in feet to NAVD88 GEOID12a elevations 
as reported in VDatum 3.2 (March 2013). The LiDAR datasets does not use the same GEOID elevations as 
VDatum. This figure shows the correction factor needed for the 2006 FEMA LiDAR dataset. This figure is 
relevant only for the west side of Buzzards Bay (Westport to the arrow in Wareham). The elevations 
represented by the color key must be subtracted from VDatum elevations to obtain reported LiDAR 
elevations. 
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Fig. 4. Fig. 3. Adjustment in converting NAVD88 GEOID9 elevations in feet to NAVD88 GEOID12a 
elevations as reported in VDatum 3.2 (March 2013). The LiDAR datasets do not use the same GEOID 
elevations as VDatum. This figure shows the correction factor (in feet) needed for the 2010 Northeast 
LiDAR. This figure is relevant only for the east side of Buzzards Bay (Bourne, Falmouth, and a portion of 
Wareham to the arrow). The elevations represented by the color key must be subtracted from VDatum 
elevations to obtain reported LiDAR elevations. Note that the correction factor is negligible for the 2010 
Northeast LiDAR dataset.
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A7. Special training certification  
Personnel performing the analysis using ArcGIS software by Esri (ArcMap 10.1) under this QAPP 
will be familiar with and have previous experience using ArcMap ArcView software, and will receive 
any necessary training by the Project Manager. 
 
 
A8. Organizational chart 
The flow of information and analyses, data, and report review will follow the organization chart in 
Fig. 6 for the various phases of the project which include (1) internal project analysis, data 
development, and review; (2) external reviews of draft datasets and draft reports, and (3) submission 
of draft final materials to EPA for review and approval. 
 

 
Fig. 5. LiDAR elevations of presumed salt marsh boundaries in non-tidally restricted areas as derived from 
Eq. 1 (only near coastal points shown and selected values are shown). Note that these values apply to the two 
LiDAR datasets used (FEMA 2006 LiDAR for western Buzzards Bay and 2010 Northeast LiDAR for eastern 
Buzzards Bay). This map also accounts for sea level rise that occurred since the midpoint of the last tidal 
epoch. 
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Fig. 6. Organizational chart. 
 
 
A9. Data quality objectives and criteria 
This effort involves a Geographic Information System (GIS) analysis using existing GIS datasets, 
particularly new LiDAR data that is available as bare earth digital elevation models (DEMs) in the 
form of triangular irregular network (TINs) or as elevation raster files. The details and quality of the 
2007 data is summarized in the 2008 report Flood Mapping Activities for Plymouth and Bristol Counties, 
Massachusetts (CDM Smith, 200814). For Cape Cod, data from the 2012 NE LiDAR project will be 
used. This data exists as DEM raster IMG files. 
 
The maps resulting from this effort can be used as planning tools to assist municipalities and state 
resource managers to identify both existing tidally restricted marshes, and those marshes that have 
the greatest potential to expand inland with sea level rise. The maps can also help target public land 
acquisitions in sensitive areas. 
 
A10. Documentation and records 
It is anticipated that a majority of the internal documentation and record transfer within the project 
will be completed electronically. Hard copy and electronic copy submittals of deliverables to EPA 
Region 1 will be submitted to MassGIS for peer review as appropriate, then delivered to EPA. 
Electronic and hard copy documentation version control, updates, storage, tracking, and distribution 
will be the responsibility of the Project Manager. Examples of electronic documentation include 
metadata to accompany GIS data files generated. Because existing software will be used for all 
phases of this project, it is not necessary to develop any new file types or protocols. 
 
  

                                                 
14 Flood Mapping Activities for Plymouth and Bristol Counties, Massachusetts. Task Order 18 Activity 1--
Topographic Data Development / Acquisition Summary Report Contract No. EME-2003-CO-0340. Task Order 
T018. Prepared for: FEMA Region I. 
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Flood Zone Analysis 
John Rockwell 

Draft Report Review 
NOAA Reviewer to be 
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(1) 

(2)
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Fig. 6. Expansion of salt marsh assuming a different marsh boundary elevation as a starting point (3.1, 3.2, 3.3, 
and 3.4 ft respectively). Maps show assumed current conditions (green), and 1-, 2-, and 4- foot sea level rise 
scenarios (red, yellow, and magenta, respectively). The actual HTL elevation at this site is 3.3 ft. 
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Section B. DATA ACQUISITION AND FILE MANAGEMENT 
This section addresses aspects of project design and implementation to ensure that appropriate 
methods for the collection of existing datasets are used in this study. This study does not require the 
generation of new field data. 
 
B1. Collection and processing of existing data  
The LiDAR GIS data for this study has already been obtained from USGS (also available through 
MassGIS) and FEMA. Although the two LiDAR sites were taken at different times, and use 
different Geoids (which are corrected for as described above) the data sets are of comparable quality 
and positional accuracy, and where they overlap, show good agreement. Any discrepancies between 
the two data sets will be discussed in the project reports.  
 
Electronic documentation and data will be stored on individual computers with weekly full backups 
and daily incremental backups. The backup data will be hosted on USB drives with additional 
monthly archiving on CDs stored offsite. Upon completion, data will be posted online in final form, 
including shapefiles with appropriate metadata. 
 
B2. Acquisition methods 
Most datasets will be obtained by email from agency contacts or downloaded from publically 
accessible websites. 
 
B3. Chain of custody 
Chain of Custody is not applicable to this study because no new data will be acquired in this study. 
 
B4. Analytical methods 
Using the high tide line elevation already calculated by the Buzzards Bay NEP as outlined in section 
6.1.1, the analytical approach used in this study will largely focus on converting LiDAR TINs to 
polygons that represent the existing HTL elevation and each sea level rise scenario change. The 
workflow for this process for TIN or IMG (imagine) files is summarized in the box below and in 
Fig. 7. For IMG raster digital elevation models, omit step 2. 
 
ArcView GIS has all the necessary functions to manipulate and intersect the datasets (3D Analyst 
and Spatial Analyst extensions needed for some steps). The GIS data can also be used in an ArcView 
environment for simple applications such as calculating the amount of area in the expansion zones. 
No field collection of data or ground truthing is required for this analysis.  
 
All data files, input and output files, spreadsheet, database, and word processing files will be stored 
in an appropriate format for the software used. Current and widely used software packages will be 
used for electronic spreadsheets (Excel) and word processing (MS Word). Intersected datasets will 
primarily be analyzed in Excel spreadsheets using built in pivot table functionality. If necessary, files 
for these software packages can be converted back and forth between formats without a loss of data.  
 
B5. Quality control 
Various visual inspections and check sum approaches will be used to ensure areas of salt marshes are 
calculated and reported correctly. Boundaries and vegetation types of representative marshes will be 
investigated to determine that the selected elevation boundary is appropriate.   
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Workflow for Converting TINs to SLR Scenario Polygons 

 
Note: For dealing with a large numbers of files, most of the steps can be batch processed independently in Arc 
Toolbox). Some steps require 3D Analyst or Spatial Analyst extension licenses. 
 
1) Add TIN files to the ArcGIS map. 
 
2) Convert the TIN to a raster file. In Arc Toolbox use the command > 3D Analyst Tools> From TIN> TIN to Raster. 
In the dialog box for this command, select output resolution by the cell size 0.25 m. Once the raster is created, you can 
classify the symbology as per the table in step 3, or importing the symbology from a raster file already processed, or just 
continue to step 3. 
 
3) Reclassify the raster files in step 2 (Spatial Analyst Tools> Reclass> Reclassify or Reclassify by table) using this table 
below to a reclass raster directory. Change the high marsh value to the LiDAR elevation specific to the site. In this 
example table, the boundary of the high marsh is presumed to be 2.9 feet. 

Class 
elevation 
NAVD88 

to 
elevation 
NAVD88 comments 

1 -100 0 lowest value to zero 
2 0 1 convenient for approximate low marsh boundary 
3 1 2.9 local upper marsh boundary (to High Tide Bush Iva) 
4 2.9 3.9 marsh boundary + 1 
5 3.9 4.9 marsh boundary + 2 
6 4.9 6.9 marsh boundary +43 
7 6.9 100 6.9 to highest value 

 
4) Export reclassified raster to polygon coverage (Conversion Tools> From Raster> Raster to Polygon with simplify 
polygons checked) into recoded_rasters directory. Make sure the file name indicates high tide boundary elevation (e.g. 
"30" for 3.0 feet, "31" for 3.1 feet, etc.) 
 
5) Repair the geometry of this file (Data Management Tools> Features>Repair Geometry). 
 
6) Aggregate isolated depressions in higher elevation zone into the higher elevation zone. To do this, run Analysis 
Tools> Proximity> Polygon Neighbors reporting by both ID and GRIDCODE and save to recode_rasters directory. 
Open the resulting dbf file in Excel to prepare a pivot table using source ID as the row labels and the following value 
fields: average source grid code, number of neighbors, average neighbor grid code (formatted to 2 decimal places), and 
sum of number of nodes. These values must exclude node neighbors (filter by node=0; neighbors defined only by a 
shared point are excluded, neighbors must have a shared edge, sum of nodes should equal zero as a cross check). Export 
the resulting table as a CSV file for joining by polygon SRC ID. Delete blank header row and the last summation row of 
the pivot table in the CSV file. Header labels must be ArcGIS format compliant. 
 
7) Export the joined table as a new shapefile. Add additional field call FIN_GRIDCD (final grid code). Assign final grid 
code the value of the original gridcode, then change it according to these rules: 
a) For each polygon ID, if the mean neighbor grid code is exactly 1 unit higher or greater, the original grid code is 
increased by one, otherwise the original grid code remains the same. This rule results in depressions that are completely 
surrounded by higher areas being assigned the same code as the surrounding high areas. 
Elevation will be ignored. The results of steps 6 and 7 are shown in Fig. 7. 
 
Note on assigning generated spline interpolation HTL raster model: Extract raster elevations to point coverage as 
follows: Spatial Analyst>Extract values to Points> (select point & raster coverages)> (join exported file to points)



 

20 
 

B6-B9. Standard QA plan data acquisition elements 
These standard QA plan elements are not applicable because no new data will be acquired in this 
study. The project involves only a synthesis and analysis of existing data using the protocols 
described. 
 
B10. Data Management 
The Buzzards Bay NEP is the governmental authority for storage, access, and disposal of all records. 
Relevant records and data pertaining to the project will be sent to EPA in the final report. In 
addition, all hard copy project files will be stored in the EPA OCCWQ office for at least five years 
after the project’s termination, and then moved to the OCC warehouse indefinitely. All electronic 
files will be maintained on the EPA OCC electronic server indefinitely. Digital data will be posted 
on the Buzzards Bay NEP website www.climate.buzzardsbay.org. All GIS data files will be fully 
documented in corresponding Metadata files. 
 

Section C. ASSESSMENT AND OVERSIGHT 
This section addresses the activities for assessing the effectiveness of the implementation of the 
project and associated QA and QC activities, particularly the development of the estimated 
approximate salt marsh boundaries for non-tidally restricted areas, and their expansion with the 
three sea level rise scenarios. This section also applies to the review of draft materials by outside 
reviewers. 

Fig. 7. Processing of digital elevation model results to assign isolated depressions (in Fig. left) to higher 
elevation classes (resulting final classification of elevation scenarios on right). 
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C1. Data review, validation, and verification requirements 
After the elevations of the upper salt marsh boundary are estimated from the predicted high tide line 
elevation. Selected sites will be confirmed by visual inspection of orthophotographs and with field 
photographic documentation of vegetation types. This information will be used to discuss the 
general reliability of the approach in the study reports. 
 
All resulting maps will be reviewed by the Project Manager and GIS QAQC officer for consistency 
among the data sets and to ensure correct elevations were selected in the LiDAR datasets. These 
final coverages will also be sent to a NOAA and EPA staffer for review. As part of the data review 
and validation, inadequacies of the dataset or inconsistencies will be discussed with the Project 
Manager. Any problem areas shall be documented and revised if necessary.  
 

Section D. DATA VALIDATION AND USABILITY 
This section describes QA activities that occur after the data collection or generation phase of the 
project is completed, specifically related to the draft and final reports and maps to be prepared for 
coastal resource managers. Implementation of these elements ensures that the data conform to the 
specified digital quality objectives (DQOs) criteria, thus achieving the project objectives. 
 
D1. Validation and verification methods 
Because this project involves an extrapolation of a natural resource boundary based on assumed 
elevations that vary around Buzzards Bay, there are uncertainties in NOAA's tidal models, and 
because the LiDAR dataset being used has its own uncertainties, the proper caveats will be 
distributed with the datasets and findings. However, we will conduct some real world validation or 
verification of the boundaries of salt marshes in non-tidally restricted areas to ensure that the 
elevation of the high tide line is generally appropriate marsh boundary for the analysis. We leave 
open-ended how quickly the 1, 2, and 4-ft elevation increases may occur, so the maps produce will 
predict salt marsh elevations with the specific increases in sea level. 
 
 
D2. Reconciliation with user requirements 
Results will be reviewed internally and externally, as described, to assess usability in the context of 
their specific intended use (identified in project specific QAPP appendices). Project leaders will meet 
with outside agency representatives (at least once) to reconcile any differences between data quality 
and data requirements. Specifically, once the final maps are determined to meet the DQOs of the 
project, the maps and draft report of findings will be posted on the Buzzards Bay NEP website for 
use by natural resource managers at all levels of government. 
 
Comments received will be included in the final reports and maps. In general, the maps produced 
will be deemed usable if acceptance criteria are met and the Project Manager determines that 
municipal comments were suitably addressed. However, if performance criteria do not meet the 
project’s requirements for DQO’s as outlined in this QAPP, the shapefiles may be revised. A 
QAQC report on all of the above items will be included as an Appendix to the Final Report to each 
municipality. 
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If Data Quality Objectives are not met, corrective actions will include discussion with MassGIS 
regarding rejecting or revising datasets, and updates of related reports and maps. 
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